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1. L. S. Compliance In Review

L.S. Compliance - Accreditations and Listing’s

As an EMC Testing Laboratory, our Accreditation and Assessments are recognized
through the following:

A2LA — American Association for Laboratory Accreditation
Accreditation based on ISO/IEC 17025 : 1999
with Electrical (EMC) Scope of Accreditation
A2LA Certificate Number: 1255.01

Federal Communications Commission (FCC) — USA
Listing of 3 Meter Semi-Anechoic Chamber based on Title 47 CFR — Part 2.948
FCC Registration Number: 90756

Listing of 3 and 10 meter OATS based on Title 47CFR — Part 2.948
FCC Registration Number: 90757

Industry Canada
On file, 3 Meter Semi-Anechoic Chamber based on RSS-212 — Issue 1

File Number: IC 3088-A

On file, 3 and 10 Meter OATS based on RSS-212 — Issue 1
File Number: IC 3088

U. S. Conformity Assessment Body (CAB) Validation
Validated by the European Commission as a U. S. Competent Body operating under
the U. S. /EU, Mutual Recognition Agreement (MRA) operating under the European
Union Electromagnetic Compatibility —Council Directive 89/336/EEC, Article 10.2.
Date of Validation: January 16, 2001

Validated by the European Commission as a U.S. Notified Body operating under the
U.S./EU, Mutual Recognition Agreement (MRA) operating under the European Union
Telecommunication Equipment — Council Directive 99/5/EC, Annex V.

Date of Validation: November 20, 2002
Notified Body Identification Number: 1243
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2. AZ2LA Certificate of Accreditation

THE AMERICAN
ASSOCIATION

FOR LABORATORY
ACCREDITATION

ACCREDITED LABORATORY
A2LA has accredited

L.S. COMPLIANCE, INC.
Cedarburg, WI

for technical competence in the field of

Electrical Testing

The accreditation covers the specific tests and types of tests listed on the agreed
scope of accreditation. This laboratory meets the requirements of ISO/IEC 17025 -
1999 "General Requirements for the Competence of Testing and Calibration
Laboratories” and any additional program requirements in the identified field of testing.
Testing and calibration laboratories that comply with this International Standard also
operate in accordance with ISO 9001 or ISO 9002 (1994).

Presented this 26" day of March 2003.

(e Moo

President ¢

For the Accreditation Council
Certificate Number 1255.01
Valid to January 31, 2005

For tests or types of tests to which this accreditation applies,
please refer to the laboratory's Electrical Scope of Accreditation.
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3. A2LA Scope of Accreditation

@D American Association for Laboratory Accreditation

SCOPE OF ACCREDITATION TO ISO/IEC 17025-1999

James Blaha

Valid to: January 31, 2005

laboratory to perform the following tests:

Test
Emissions

Conducted
Continuous/Discontinuous

Radiated

Current Harmonics
Voltage Fluctuations & Flicker

Immunity

Conducted Immunity
Fast Transients/Burst

Surge
RF Fields

Voltage Dips/Interruptions

v

(A2LA Cert. No. 1255-01) 05/13/03

L.S. COMPLIANCE, INC.
W66 N220 Commerce Court
Cedarburg, WI 53012

Phone: 262 375 4400

ELECTRICAL (EMC)

Certificate Number: 1255-01

In recognition of the successful completion of the A2LA evaluation process, accreditation is granted to this

Test Method(s)

Code of Federal Regulations (CFR) 47,

FCC Method Parts 15, 18 using ANSI C63.4;
EN: 55011, 55022, 50081-1, 50081-2;
CISPR: 11, 12, 14-1, 22;

CNS 13438

Code of Federal Regulations (CFR) 47,

FCC Method Parts 15, 18 using ANSI C63.4;
EN: 55011, 55022, 50081-1, 50081-2;
CISPR: 11, 12, 14-1, 22;

CNS 13438

IEC 61000-3-2; EN 61000-3-2
IEC 61000-3-3; EN 61000-3-3

EN: 50082-1, 50082-2
EN 61000-6-2 -
CISPR: 14-2, 24

IEC 61000-4-4;
EN 61000-4-4
IEC: 61000-4-5; ENV 50142;
EN 61000-4-5
IEC: 61000-4-6; ENV 50141;
EN 61000-4-6

IEC 61000-4-11;
EN 61000-4-11

Yy W AP

Page 1 of 2
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4. Validation Letter — U.S. Competent Body for EMC Directive 89/336/EEC

or
f':sf UNITED STATES DEPARTMENT OF COMMERCE
2 el - Mational Institute of Standards and Technology
LS J f Gaithersburg, Maryland 20899-

100T- 1061

MIST CENTENNIAL R

January 16, 2001

Prares of

Mr. James J. Blaha

L.S. Compliance Inc.

Woo N220 Commerce Court
Cedarburg, WI 53012-2636

Dear Mr. Blaha:

I am pleased to inform you that the European Commission has validated your organization’s
nomination as a U.S. Conformity Assessment Body (CAB) for the following checked (v)
sectoral annex(es) of the U.S.-EU Mutual Recognition Agreement (MRA).

(+") Electromagnetic Compatibility-Council Directive 89/336/EEC, Article 10(2)

()} Telecommunication Equipment-Council Directive 98/13/EC, Annex 111

() Telecommunication Equipment-Council Directive 98/13/EC, Annex 11l and IV
Identification Number:

() Telecommunication Equipment-Council Directive 98/13/EC, Annex V
Identification Number:

This validation is only for the location noted in the address block, unless otherwise indicated
below.

(+") Only the facility noted in the address block above has been approved.
( ) Additional EMC facilities:
( ) Additional R&TTE facilities:

Please note that an organization’s validations for various sectors of the MRA are listed on our
web site at http://ts.nist.gov/mra. You may now participate in the conformity assessment
activities for the operational period of the MRA as described in the relevant sectoral annex or
annexes of the U.S.-EU MRA document.

NIST will continue to work with you throughout the operational period. All CABs validated for
the operational phase of the Agreement must sign and return the enclosed CAB declaration form,
which states that each CAB is responsible for notifying NIST of any relevant changes such as
accreditation status, liability insurance, and key staff involved with projects under the MRA.
Please be sure that you fully understand the terms under which you are obligated to operate as a
condition of designation as a CAB. As a designating authority, NIST is responsible for
monitoring CAB performance to ensure continued competence under the terms of the MRA.

NIST
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5. Signature Page

mea 0. oAty

Prepared By: February 18, 2005

Teresa A. White, Document Coordinator Date

Tested By: W February 18, 2005

Abtin Spantman, EMC Engineer Date

7, .
Mo < S
Approved By: it February 18, 2005

Kenneth L. Boston, EMC Lab Manager Date
PE #31926 Licensed Professional Engineer
Registered in the State of Wisconsin, United States
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6. Product and General Information

Manufacturer: | Encom Wireless Data Solutions, Inc.
Date(s) of Test: | August 31°" through November 28™, 2004
Test Engineer(s): | Tom Smith |V | Abtin Spantman | | Ken Boston
Model #: | ‘ENC-900’ 1000 mW Radio Module
Serial #: | Engineering Unit #43
Voltage: | 3.80 VDC, 1000 mA
Operation Mode: | Normal, continuous transmit, and ‘Hopping’ mode

7. Introduction

Between August 31°" through November 28™, 2004, a series of Conducted and Radiated RF
Emission tests were performed on one sample of the Encom Wireless Data Solutions’, Model
Number: ‘ENC-900 (1000 mW) Radio Module’, Serial Number: ‘Engineering Unit #43’, here forth
referred to as the “Equipment Under Test” or “EUT”. These tests were performed using the
procedures outlined in ANSI C63.4-2003 for intentional radiators, and in accordance with the
limits set forth in FCC Part 15.247 (Industry Canada RSS-210) for a transmitter or intentional
radiator. These tests were performed by Abtin Spantman, EMC Engineer at L.S. Compliance,
Incorporated.

All Radiated and Conducted Emission tests were performed upon the EUT to measure the
emissions in the frequency bands described in Title 47 CFR, FCC Part 15, including 15.35,
15.209, 15.247 and Industry Canada RSS-210 to determine whether these emissions are below
the limits expressed within the standards. These tests were performed in accordance with the
procedures described in the American National Standard for methods of measurement of Radio-
Noise Emissions from Low-Voltage Electrical and Electronic Equipment in the Range of 9 kHz to
40 GHz (ANSI C63.4-2003). Another document used as a reference for the EMI Receiver
specification was the Comite International Special Des Perturbations Radioelelectriques
(CISPR) Number 16-1, 2003.

All tests were performed at L.S. Compliance, Inc., in Cedarburg, Wisconsin, unless otherwise
noted.
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8. Product Description

The ENCOM ‘ENC-900 (1000 mW) Radio Module’ is a frequency hopping spread spectrum
transceiver operating in the 902 MHz to 928 MHz ISM band. It transmits with a maximum of 1
Watt (+30 dBm) at the antenna port.

The receiver is a direct conversion receiver with no frequency offset for the local oscillator.
Individual channel selection occurs within the receiver without the need for external filtering. A
band-pass filter restricts the receiver to the stated ISM band.

The module uses an End-Launch MCX Jack on the RF antenna port, and standard 0.1” SIP
headers for power, data, and control signal connections.

The users communicate with this module via an asynchronous RS-232 type interface through
the SIP headers. The RS-232 interface is used for initial programming of the unit as well as data
transfer during normal operation. All data that users send to the module is buffered in banks of
SRAM memory, packetized with appropriate header information, and sent over the air at a fixed
bit rate. The microcontroller inside the module precisely controls the bit-width, packet size, and
hopping algorithm, to ensure that the RF occupied bandwidth and channel dwell-times remain
constant.

Users need to provide 3.8 VDC, 1000 mA nominal power to the module. The microcontroller
monitors the power supply voltage on a continuous basis. Should the voltage be outside the
normal specified operating parameters the unit will refuse to transmit. The ENC-900 hops to a
new frequency after a predetermined fixed time interval set by the user, ranging from 8 ms to
120 ms. The ENC-900 hops according to a pseudorandom pattern of 50 channels which are
chosen from a pool of 127 available channels. Each radio is programmed with a seed value
which determined the table based on a defined pseudorandom generator, and the dwell time is
equal among channels.
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9. Test Requirements

The above mentioned tests were performed in order to determine the compliance of the Encom
Wireless Data Solutions’, Model Number: ‘ENC-900 (1000 mW) Radio Module’ with limits
contained in various provisions of Title 47 CFR, FCC Part 15, including:

15.207 15.247b 15.247¢g
15.205 15.247c 15.209
15.247a 15.247d

10. Summary of Test Report

DECLARATION OF CONFORMITY

The Encom Wireless Data Solutions’, Model Number: ‘ENC-900 (1000 mW) Radio Module’ was
found to MEET the requirements as described within the specification of Title 47 CFR FCC, Part
15.247, and Industry Canada RSS-210, Section 6.2.2(0) for a Frequency Hopping Spread
Spectrum Transmitter.

Some emissions are seen to be within 3 dB of their respective limits. As these levels are within
the tolerances of the test equipment and site employed, there is a possibility that this unit, or a
similar unit selected out of production may not meet the required limit specification if tested by
another agency.

The enclosed test results pertain to the sample(s) of the test item listed, and only for the tests
performed on the data sheets. Any subsequent modification or changes to the test items could
invalidate the data contained herein, and could therefore invalidate the findings of this report.
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11. Conducted Emissions Test, Occupied Bandwidth

The 20 dB bandwidth requirement found in FCC Part 15.247(a)(1)(i) states a maximum allowed
occupied bandwidth of 500 kHz. For this portion of the tests, a direct measurement of the
transmitted signal was performed at the antenna port of the EUT, via a cable connection to the
HP E4407B spectrum analyzer. The loss from the cable and the attenuator were added on the
analyzer as gain offset settings (-0.64 dB Gain), there by allowing direct readings of the
measurements made without the need for any further corrections. A Hewlett Packard model
E4407B spectrum analyzer was used with the resolution bandwidth set to 10 kHz for this portion
of the tests. The EUT was configured to run in a continuous transmit mode, while being
supplied with typical data as a modulation source. The spectrum analyzer was used in peak-
hold mode while measurements were made, as presented in the chart below.

From this data, the bandwidth of Channel 64, which is the closest data to the specification limit,
is 343 kHz, which is below the maximum of 500 kHz.

Sheiig Center Frequency Measured 20 dB BW Maximum Limit
(MHz) (kHz) (kHz)
01 903.392 343 500
64 914.996 343 500

Plots of Occupied Bandwidth
Channel 01 Occupied Bandwidth

% Agilent  16:53:47 Mov 28, 2004 | Marker |
Mkrl & 343 kHz|t
Ref 38 dBm Atten 40 dB Ext PG -0.64 dB -0.733 dB Select Marker
Peak
1 2 3 4
Log
5
dB/ Normal
Marker & elta
343.@@@ kHZ Delta Pair
-B)/33 dB | 1 (Tracking Ref)
¢ & Ref Deltal
s Span Pair
$3 FC S C
aA pan enter
Off
| More
Center 992.4 MHz Span 1 MHz 1 of 2
#Res BW 18 kHz #UBW 19 kHz Sweep 12,88 ms (401 pts)
|
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Channel 64 Occupied Bandwidth

% Agilent  16:56:43 Mov 28, 2004 | Marker |
Mkrl & 343 kHz|t
Ref 30 dBm Atten 46 dB Ext PG -8.64 dB -2.435 dB || select Marker
Peak
1 2 3 4
Log
5
dB/ Normal
Marker & elta
343.@@@ kHZ Delta Pair
-2435 dB 1<f {Tracking Ref)
1 Ref Deltal
s Span Pair
$3 FC 5 C
AA pan enter
Off
Center 915 MHz Span 1 Mz flore
#Res BW 18 kHz #UBW 19 kHz Sweep 12,88 ms (401 pts)
|

Channel 127 Occupied Bandwidth

% Agilent  165:59:65 Mov 28, 2604 | Marker |
Mkrl & 293 kHz|t
Ref 30 dBm fAtten 40 dB Ext PG -0.64 dB -6.67 dB |[ s elect Marker
Peak
1 2 3 4
Log
5
dB/ Normal
Marker & Delta
293.000 kHz| ., s Delta Pair
-0.67 dB ¢ ) {Tracking Ref)
Ref Delta|
M 52 Span Pair
53 FC s C
AA pan enter
Off
Center 927.6 Mz Span 1 iz flore
#Res BW 18 kHz #UBW 19 kHz Sweep 12,88 ms (401 pts)
|
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12. Conducted Emissions Test, Power Output 15.247(b)

The conducted RF output power of the EUT was measured at the antenna port using a short RF
cable for the spectrum analyzer. The loss from the cable and the attenuator were added on the
analyzer as gain offset settings (-0.64 dB Gain), there by allowing direct readings of the
measurements made without the need for any further corrections. The EUT was configured to
run in a continuous transmit mode, while being supplied with typical data from a large test data
file. The spectrum analyzer was used with resolution and video bandwidths set to 1 MHz, and a
span of 5 MHz, with measurements from a peak detector presented in the chart below. RF
Power Output was also monitored while varying the DC voltage as sourced by a DC bench type
power supply. No considerable variation in output power was seen while setting the DC voltage
to 3.23 VDC (-15%) or to 4.37 VDC (+15%).

Channel Center Frequency Limit Measured Power Margin
(MHz) (dBm) (dBm) (dB)
01 902.3 30 dBm 28.26 1.74
64 915.1 30 dBm 29.11 0.89
127 927.5 30 dBm 28.96 1.04
Transmitter © @ e
Under Test l
Channel 01 Conducted Power Output
% Agilent  17:22:41 Mov 28, 2604 | Peak Search |
Mkrl 98229 MHz|t
Ref 48 dBm Atten 58 dB Ext PG -0.64 dB 28.26 dBm
Peak Meas Tools»
Log 1
18 ~
dB/ Next Peak
Marker Next Pk Right
902.290P00 MHz
7876 dBm Next Pk Left
Y1 52
$3 FC Min Search
AR
Pk-Pk Search
Center 902.4 Mz Span 20 Mz flore
#Res BW 1 MHz #UBH 1 MHz Sweep 4 ms (401 pts) .
|
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Channel 64 Conducted Power Output

% Agilent  17:21:56 Mov 28, 2004 | Peak Search |
Mkrl 915.1@ MHz|t
Ref 48 dBm Atten 58 dB Ext PG -0.64 dB 29.11 dBm
Peak Meas Tools»
Log N
18
dB/ Next Peak
Marker Next Pk Right
915.100P60 MHz
2911 dBm Next Pk Left
Y1 52
$3 FC Min Search
AR
Pk-Pk Search
Center 915 MHz Span 20 Mz flore
#Res BW 1 MHz #UBH 1 MHz Sweep 4 ms (401 pts)
|

Channel 127 Conducted Power Output

% Agilent  17:21:12 Mov 28, 2604 | Peak Search |
Mkrl 927.5@ MHz|t
Ref 48 dBm Atten 58 dB Ext PG -0.64 dB 28.96 dBm
Peak Meas Tools»
Log 1
18
dB/ Next Peak
Marker Next Pk Right
927.500P00 MHz
28.96 dBm Next Pk Left
Y1 52
$3 FC Min Search
AR
Pk-Pk Search
Center 927.6 Mz Span 20 Mz flore
#Res BW 1 MHz #UBH 1 MHz Sweep 4 ms (401 pts)
|
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13. Frequency and Power Stability over Voltage Variations

For this test, the EUT was place in continuous transmit mode. Power was supplied by an
external bench-type variable power supply, and the frequency of operation was monitored using
the spectrum analyzer. The frequency was measured with a receiver resolution bandwidth of 10
Hz, and video bandwidth of 10 Hz. Channel 127 produced the widest frequency variation during
the tests.

DC Voltage Source
3.23V 3.80V 437V

Channel 1 28.1 (dBm) 28.0 (dBm) 28.0 (dBm)
Channel 64 28.2 (dBm) 28.8 (dBm) 28.6 (dBm)
Channel 127 27.9 (dBm) 28.6 (dBm) 28.1 (dBm)

DC Voltage Source

3.23V 3.80V 437V

Channel 1 902.40645 (MHz) 902.40648 (MHz) 902.40655 (MHz)
Channel 64 914.99525 (MHz) 914.99525 (MHz) 914.99560 (MHz)
Channel 127 927.59065 (MHz) 927.59080 (MHz) 927.59110 (MHz)

The power was then cycled On/Off to observe system response. No unusual response was
observed, the emission characteristics were well behaved during power loss. After power was
returned, the system needs to be re-initialized to transmit and the system returned to the same
state of operation as before the power cycle. The system did not transmit without re-
initialization.

No anomalies were noted, in the measured transmit power, varying less than 1 dB, during the
voltage variation tests.
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14. Conducted Emissions Test, Spurious Emissions 15.247(d)

FCC Part 15.247(d) requires a measurement of conducted harmonic and spurious RF emission
levels, as reference to the carrier level when measured in a 100 kHz bandwidth. For this test,
the spurious and harmonic RF emissions from the EUT were measured at the EUT antenna port
using a short RF cable. The loss from the cable was added on the analyzer as gain offset
settings, there by allowing direct readings of the measurements made without the need for any
further corrections. A Hewlett Packard model E4407B spectrum analyzer was used with the
resolution bandwidth set to 100 kHz for this portion of the tests. The unit was configured to run
in a continuous transmit mode, while being supplied with typical data as a modulation source.
The spectrum analyzer was used with measurements from a peak detector presented in the
chart below. Screen captures were acquired and any noticeable spurious and harmonic signals
were identified and measured.

No significant emissions could be noted within -50 dBc of the fundamental level for this product.

Channel 01 Channel 64 Channel 127
Fundamental + 28.4 (dBm) + 28.6 (dBm) + 28.2 (dBm)
2" Harmonic - 35.2 (dBm) - 38.0 (dBm) - 37.9 (dBm)
3rd Harmonic Note (1) Note (1) Note (1)
4th Harmonic Note (1) Note (1) Note (1)
5th Harmonic Note (1) Note (1) Note (1)
Notes:

(1) Measurement at system noise floor.
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Plots of Conducted Spurious and Fundamental Levels

Channel 01, shown from 30 MHz up to 1000 MHz

% Agilent  17:36:64 MNov 28, 2004 | Marker |
Mkrl & -238 MHz|t
Ref 40 dBm Atten 50 dB Ext PG -0.64 dB ~54.22 4B ([ clect Marker
Peak
i 2 3 4
Log 1|r
18
dB/ Normal
Marker & Delta
-238.000000 MHz Delta Pair
5422 dB (Tracking Ref)
Ref Delta|
T
s b Span Pair
53 FCLnfie 5 C
AA pan enter
Off
Start 38 Mz Stop 1 GHz flore
#Res BH 100 kHz #UBH 188 kHz Sweep 125 ms (401 pts)
|

Channel 01, shown from 1000 MHz up to 10,000 MHz

% Agilent  17:41:42 Mov 28, 2604 | Peak Search |
Mkrl 1.81 GHz

|
Ref 38 dBm Atten 48 dB Ext PG -0.64 dB -35.1% dBm
Peak Meas Tools»
Log
18
dB/ Next Peak
Marker Next Pk Right
1.810000007 GHz
-35.18 dBm Next Pk Left
v os2[ 4
53 FC s i Min Search
AA
Pk-Pk Search
Start 1 GHz Stop 10 GHz flore
#Res BH 100 kHz #UBH 188 kHz Sweep 1.16 5 (481 pts)
|
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Channel 64, shown from 30 MHz up to 1000 MHz

% Agilent  17:37:12 Mov 28, 2004 | Marker |
Mkrl & =313 MHz|t
Ref 40 dBm fAtten 50 dB Ext PG -0.64 dB -56.34 &8 [[calect Marker
Peak
1 2 3 4
Log i
18
dB/ Normal
Marker & Delta
-313.000600 MHz Delta Pair
-56.34 dB {Tracking Ref)
Ref Delta|
1]
s b Span Pair
53 FC s C
HH [an enter
Off
Start 38 Mz Stop 1 GHz flore
#Res BH 100 kHz #UBH 188 kHz Sweep 125 ms (401 pts)
|

Channel 64, shown from 1000 MHz up to 10,000 MHz

% Agilent  17:39:45 Mov 28, 2604 | Peak Search |
Mkrl 2.98 GHz|t
Ref 38 dBm Atten 48 dB Ext PG -0.64 dB -35.44 dBm
Peak Meas Tools»
Log
18
dB/ Next Peak
Marker Next Pk Right
2.98000PB00 GHz
-3%.44 dBm Next Pk Left
V1 s2 Lo
$3 FC b yrund Min Search
AA
Pk-Pk Search
Start 1 GHz Stop 10 GHz flore
#Res BH 100 kHz #UBH 188 kHz Sweep 116 5 (401 pts)
|
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Channel 127, shown from 30 MHz up to 1000 MHz

% Agilent  17:34:67 Mov 28, 2004 | Marker |
Mkrl & —-141 MHz|t
Ref 40 dBm fAtten 50 dB Ext PG -0.64 dB -56.21 &8 [[salect Marker
Peak 1 o 3 4
Log N L
18
dB/ Normal
Marker & Delta
-141.000600 MHz Delta Pair
-56.21 dB {Tracking Ref)
Ref Delta|
1
s ? Span Pair
53 FClocms S n
HH [an enter
Off
Start 38 Mz Stop 1 GHz flore
#Res BH 100 kHz #UBH 188 kHz Sweep 125 ms (401 pts)
|

Channel 127, shown from 1000 MHz up to 10,000 MHz

% Agilent  17:43:25 Mov 28, 2604 | Peak Search |
Mkrl 2.98 GHz|t
Ref 38 dBm Atten 48 dB Ext PG -0.64 dB -35.49 dBm
Peak Meas Tools»
Log
18
dB/ Next Peak
Marker Next Pk Right
2.98000000Y GH=
-35.49 dBm Next Pk Left
V1 s2 s
$3 FC sl Min Search
AA
Pk-Pk Search
Start 1 GHz Stop 10 GHz flore
#Res BH 100 kHz #UBH 188 kHz Sweep 1.16 5 (481 pts)
|
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15. Conducted Emissions Test, Minimum Channel Separation

Part 15.247(a)(1) requires a minimum channel separation of 25 kHz or the equivalent of the 20
dB occupied bandwidth of the fundamental transmission, whichever is greater. An HP E4407B
spectrum analyzer was used with a resolution bandwidth of 30 kHz to measure the channel

separation of the EUT.

The minimum channel-separation measured for this device is 400 kHz. The maximum occupied
bandwidth of the device, as reported in the previous section is 343 kHz. The minimum channel
separation for the EUT exceeds both the 25 kHz criteria and the 20 dB occupied bandwidth
criteria, and hence meets the requirements. The following plots describe this spacing, and also

establish the number of hop channels, total of 50.

Frequency Span Number of Channels | Minimum Separation
902-904 MHz 4 400 kHz
904-906 MHz 5 400 kHz
906-908 MHz 4 400 kHz
908-910 MHz 4 400 kHz
910-912 MHz 4 400 kHz
912-914 MHz 4 400 kHz
914-916 MHz 4 400 kHz
916-918 MHz 4 400 kHz
918-920 MHz 3 400 kHz
920-922 MHz 4 400 kHz
922-924 MHz 4 400 kHz
924-926 MHz 4 400 kHz
926-928 MHz 2 400 kHz

L.S. Compliance, Inc.
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Plots of Channel Separations

Channel Spacing and Assignments between 902 MHz to 904 MHz

% Agilent  13:14:13 Mov 28, 2604 | Marker |
Mkrl & 466 kHz|t
Ref 30 dBm Atten 40 dB Ext PG -0.64 dB 2.609 dB [[colect Marker
Peak
1 2 3 4
Log
5
dB/ e Normal
Marker & elta
4@&.@@@ kHZ Delta Pair
0.609 dB {Tracking Ref)
Ref Deltal
M 52 Span Pair
53 FC s C
an pan enter
off
Start 902 MHz Stop 904 Mz flore
#Res BW 30 kHz #BH 38 kHz #Sweep 100 ms (401 pts)
|

Channel Spacing and Assignments between 904 MHz to 906 MHz

% Agilent  18:15:38 Mov 28, 2004 | Marker |
Mkrl & 408 kHz|t
Ref 30 dBm Atten 46 dB Ext PG -8.64 dB -0.198 dB || select Marker
Peak
1 2 3 4
Log
5
dB/ ale Normal
Marker & elta
4@&.@@@ kHZ Delta Pair
-B.198 dB {Tracking Ref)
Ref Deltal
M 52 Span Pair
$3 FC 5 C
AA pan enter
Off
Start 904 Mz Stop 906 Mz flore
#Res BW 30 kHz #BH 38 kHz #Sweep 100 ms (401 pts)
|
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Channel Spacing and Assignments between 906 MHz to 908 MHz

% Agilent  13:17:68 Mov 28, 2004 | Marker |
Mkrl & 408 kHz|t
Ref 30 dBm Atten 46 dB Ext PG -8.64 dB 0.147 4B [l s glect Marker
Peak
1 2 3 4
Log
5
dB/ e Normal
Marker & elta
4@&.@@@ kHZ Delta Pair
0.147 dB {Tracking Ref)
Ref Deltal
M 52 Span Pair
$3 FC 5 C
AA pan enter
Off
Start 906 Mz Stop 908 Mz flore
#Res BW 30 kHz #BH 38 kHz #Sweep 100 ms (401 pts)
|

Channel Spacing and Assignments between 908 MHz to 910 MHz

% Agilent  13:19:64 Nov 28, 2604 | Marker |
Mkrl & 466 kHz|t
Ref 30 dBm fAtten 40 dB Ext PG -0.64 dB 2644 6B |[s olect Marker
Peak
1 2 3 4
Log
5
dB/ e Normal
Marker & Delta
400.000 kHz Delta Pair
P.044 ¢dB (Tracking Ref)
Ref Delta|
M 52 Span Pair
53 FC s C
AA pan enter
Off
Start 988 Mz Stop 910 Mz flore
#Res BW 30 kHz #BH 38 kHz #Sweep 100 ms (401 pts)
|
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Channel Spacing and Assighments between 910 MHz to 912 MHz

% Agilent  18:21:29 Mov 28, 2604 | Marker |
Mkrl & 408 kHz|t
Ref 38 dBm Atten 40 dB Ext PG -0.64 dB 5.034 dB Select Marker
Peak
1 2 3 4
Log
5
dB/ e Normal
Marker A Delta
400.000 kHz Delta Pair
0.034 ¢B {Tracking Ref)
Ref Deltal
M 52 Span Pair
$3 FC 5 C
AR pan enter
Off
l More
Start 918 MHz Stop 912 MHz 1 of 2
#Res BW 30 kHz #BH 38 kHz #Sweep 100 ms (401 pts)
|

Channel Spacing and Assignments between 912 MHz to 914 MHz

% Agilent  13:24:24 Nov 28, 2004 | Marker |
Mkrl & 466 kHz|t
Ref 30 dBm fAtten 40 dB Ext PG -0.64 dB 012 dB |[select Marker
Peak
1 2 3 4
Log
5
dB/ e Normal
Marker & elta
4@&.@@@ kHZ Delta Pair
012 gB {Tracking Ref)
Ref Deltal
M 52 Span Pair
53 FC s C
AA pan enter
off
I
Start 912 Mz Stop 914 1z flore
#Res BW 30 kHz #BH 38 kHz #Sweep 100 ms (401 pts)
|
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Channel Spacing and Assighments between 914 MHz to 916 MHz

% Agilent  18:26:37 Nov 28, 2004 | Marker |
Mkrl & 466 kHz|L
Ref 30 dBm Atten 40 dB Ext PG —0.64 dB -0.118 dB [[coiect Marker
Peak
1 2 3 4
Log
5
dB/ 1 Normal
Marker & elta
4@&.@@@ kHZ Delta Pair
-p.118dB {Tracking Ref)
Ref Deltal
M 52 Span Pair
53 FC s C
AA pan enter
Off
Start 914 Mz Stop 916 Mz flore
#Res BW 30 kHz #BH 38 kHz #Sweep 100 ms (401 pts)
|

Channel Spacing and Assighments between 916 MHz to 918 MHz

% Agilent  18:27:32 Nov 28, 2004 | Marker |
Mkrl & 466 kHz|L
Ref 30 dBm fAtten 48 dB Ext PG -0.64 dB -0.095 dB [['serect Marker
Peak
1 2 3 4
Log
5
dB/ v Normal
Marker 4 Delta
4@&.@@@ kHZ Delta Pair
—@%5 1B {Tracking Ref)
Ref Delta|
M 52 Span Pair
53 FC s C
HH pan enter
Off
Start 916 MHz Stop 918 MHz flore
#Res BW 30 kHz #BH 38 kHz #Sweep 100 ms (401 pts)
|
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Channel Spacing and Assignments between 918 MHz to 920 MHz

% Agilent  13:23:44 Now 28, 2004 | Marker |
Mkrl & 466 kHz|L
Ref 30 dBm Atten 40 dB Ext PG —0.64 dB 8137 &8 | select Marker
Peak
1 2 3 4
Log
5
dB/ x Normal
Marker & elta
4@&.@@@ kHZ Delta Pair
B.137 dB {Tracking Ref)
Ref Deltal
M 52 Span Pair
53 FC s C
aA pan enter
Off
Start 918 Mz Stop 520 Tz flore
#Res BW 30 kHz #BH 38 kHz #Sweep 100 ms (401 pts)
|

Channel Spacing and Assignments between 920 MHz to 922 MHz

% Agilent  18:32:65 Nov 28, 2004 | Marker |
Mkrl & 466 kHz|L
Ref 30 dBm fAtten 48 dB Ext PG -0.64 dB 0.663 dB |[colect Marker
Peak
1 2 3 4
Log
5 1R
dB/ Normal
Marker & Delta
400.000 kHz Delta Pair
B.063 dB {Tracking Ref)
Ref Delta|
M 52 Span Pair
53 FC s C
AR pan enter
Off
Start 920 MHz Stop 922 MHz flore
#Res BW 30 kHz #BH 38 kHz #Sweep 100 ms (401 pts)
|
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Channel Spacing and Assignments between 922 MHz to 924 MHz

% Agilent  18:33:57 Nov 28, 2004 | Marker |
Mkrl & 466 kHz|t
Ref 38 dBm Atten 40 dB Ext PG -0.64 dB $.165 dB Select Marker
Peak
1 2 3 4
Log
5
1R
dB/ Normal
Marker & elta
4@&.@@@ kHZ Delta Pair
8.] @15 d¢B {Tracking Ref)
Ref Deltal
M 52 Span Pair
$3 FC S C
aA pan enter
Off
| More
Start 922 MHz Stop 924 MHz 1 of 2
#Res BW 30 kHz #BH 38 kHz #Sweep 100 ms (401 pts)
|

Channel Spacing and Assignments between 924 MHz to 926 MHz

% Agilent  18:35:32 Nov 28, 2004 | Marker |
Mkrl & 466 kHz|L
Ref 30 dBm Atten 40 dB Ext PG —0.64 dB 8.254 &8 | select Marker
Peak
1 2 3 4
Log
5
1|R
dB/ Normal
Marker & elta
4@&.@@@ kHZ Delta Pair
0.254 ¢B {Tracking Ref)
Ref Deltal
M 52 Span Pair
53 FC s C
AA pan enter
off
Start 924 MHz Stop 926 Mz flore
#Res BW 30 kHz #BH 38 kHz #Sweep 100 ms (401 pts)
|
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Channel Spacing and Assignments between 926 MHz to 928 MHz

% Agilent  18:37:15 Nov 28, 2004 | Marker |
Mkrl & 466 kHz|L
Ref 30 dBm fAtten 48 dB Ext PG -0.64 dB 0.634 dB |[colect Marker
Peak
1 2 3 4
Log
5 1|R
dB/ Normal
Marker & Delta
400.000 kHz Delta Pair
0.034 dB {Tracking Ref)
Ref Delta|
M 52 Span Pair
53 FC s C
HH pan enter
Off
Start 926 MHz Stop 928 HHz flore
#Res BW 30 kHz #BH 38 kHz #Sweep 100 ms (401 pts)
|
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16. Conducted Emissions Test, Channel Occupancy

Part 15.247(a)(1) requires a channel occupancy, for this device, of no more than 400
milliseconds in a 10 second window. The channel occupancy for this EUT was measured using
an HP E4407B spectrum analyzer, set to zero-span at the frequency of interest. With the
analyzer in peak-hold mode, the transmission lengths can be measured by adjusting the sweep
rate of the analyzer. A suitable sweep rate was used to measure the channel occupancy at the
low, mid and high channels. The longest time any transmission will occur on a single channel is
31.75 ms. With a total of 50 channels used, each occupying a 31.75 ms slot, it will take 1.59
seconds for the sequence to repeat. In a 10 second window, each channel would have 6.29
transmission cycles. The maximum occupancy in a 10 second window is calculated by
multiplying the 6.29 transmission cycles by 31.75 ms transmission duration per cycle, to arrive
at 199.7 ms total occupancy.

Frequency Occupancy Occupancy in
Channel (MHz) Per transmission | 400 ms window
(ms) (ms)
01 902.5 31.75 199.7
64 915.3 31.75 199.7
127 927.5 31.75 199.7

Plots of Channel Occupancy

Occupancy in Channel 01

% Agilent  18:61:33 Nov 28, 2004 | Marker |
Mkrl & 31.75 ms)t
Ref 30 dBm Atten 40 dB Ext PG -0.64 dB 23.71 dB Select Marker
Peak [ 1 Sy 4
1 =
Log
5
dB/ Normal
Marker & elta
31.75@@@@@@ 1([}3 Delta Pair
23.71 dB {Tracking Ref)
Ref Deltal
gé Eg Span Pair
a8 Span Center
Off
Center 9025 MHz Span 8 Hz flore
Res BW 168 kHz #YBH 106 kHz Sweep 106 ms (481 pts)
|

L.S. Compliance, Inc. Page 28 of 53

Test Report Number: 304238-TX1000 TCB R2
Prepared For: Encom Wireless Data Solutions, Inc.



Occupancy in Channel 64

% Agilent  18:63:31 Nov 28, 2004 | Marker |
Mkrl & 31.75 ms)t
Ref 30 dBm Atten 40 dB Ext PG -0.64 dB -12.88 dB Select Marker
Peak 4 1 PR
Log 1 L
5
dB/ Normal
1
K
Marker & elta
31.75@@@@@@ ms Delta Pair
-12.88 0B {Tracking Ref)
Ref Deltal
gé Eg Span Pair
a8 Span Center
Off
Center 915.3 MHz Span 8 Hz flore
Res BW 168 kHz #YBH 106 kHz Sweep 106 ms (481 pts)
|

Occupancy in Channel 127

% Agilent  17:53:11 Now 28, 2004 | Marker |
Mkrl & 31.75 ms)t
Ref 30 dBm Atten 40 dB Ext PG —0.64 dB 2219 &8 | select Marker
Peak T 1 2 3 4
1 =
Log
5
dB/ Normal
Marker & elta
R
31.75@@@@@@°m3 Delta Pair
24.19 dB {Tracking Ref)
Ref Deltal
gé Eg Span Pair
a8 Span Center
Off
Center 9275 MHz Span 8 Hz flore
Res BHW 188 kHz #UBH 188 kHz Sweep 108 ms (401 pts)
|
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The information on this page is provided by the manufacturer.

17. Equal Channel Usage

50 channels are chosen from a pool of 127 available frequencies. These channels are arrayed
in a table which the system uses to determine the next hopping channel. Each time a
transmission is made the system uses the next frequency in the table. The table is started over
once the end has been reached. Thus, any given frequency will not be reused until all other
frequencies have been accessed. This also addresses part 15.247(g) concerns.

18. Pseudorandom Hopping Pattern

The hopping table is built using an 8 bit seed into an X**+1 pseudorandom number generator
giving the possibility of 64 unique pseudorandom hopping tables. Output from the generator is
used to pick frequencies from a pool of 50 available channels. This also addresses part
15.247(h) concerns.
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19. Radiated Emissions Test

Test Setup
The test setup was assembled in accordance with Title 47, CFR FCC Part 15 and ANSI C63.4-

2003. The EUT was tested as a module, and was placed on an 80cm high non-conductive
pedestal, centered on a flush mounted 2-meter diameter turntable inside a 3 meter Semi-
Anechoic, FCC listed Chamber. A personal computer was used to program the EUT to operate
in the desired test modes. An RS-232-to-TTL interface circuit was used in between the
personal computer and the EUT. The personal computer was placed outside of the test area,
while the interface circuit was placed inside the test area.

The EUT was operated in a continuous transmit mode, using power as provided by a bench
type power supply (used on EUT module), as well as a wall type power supply (used on PC
interface device). The unit has the capability to operate on 127 channels, controlled via a
personal computer during these tests. The personal computer used a simple terminal program
to communicate and program the EUT, and a large generic data file was used as source for the
modulation of the EUT during these transmitter tests.

The applicable limits apply at a 3 meter distance. Measurements above 5 GHz were performed
at a 1.0 meter separation distance. The calculations to determine these limits are detailed in the
following pages. Please refer to Appendix A for a complete list of test equipment. The test
sample was operated on one of three (3) standard channels: low (902.392 MHz), middle
(914.996 MHz) and high (927.594 MHZz) to comply with FCC Part 15.35.

Test Procedure

Radiated RF measurements were performed on the EUT in a 3 meter Semi-Anechoic, FCC
listed Chamber. The frequency range from 30 MHz to 10000 MHz was scanned and
investigated. The radiated RF emission levels were manually noted at the various fixed degree
settings of azimuth on the turntable and antenna height. The EUT was placed on a non-
conductive pedestal in the 3 meter Semi-Anechoic Chamber, with the antenna mast placed
such that the antenna was 3 meters from the EUT. A Biconical Antenna was used to measure
emissions from 30 MHz to 300 MHz, and a Log Periodic Antenna was used to measure
emissions from 300 MHz to 1000 MHz. A Double-Ridged Waveguide Horn Antenna was used
from 1 GHz to 18 GHz. The maximum radiated RF emissions were found by raising and
lowering the antenna between 1 and 4 meters in height, using both horizontal and vertical
antenna polarities.

The EUT was tested and qualified with one type of antennas, as covered in this report.

The antenna was an Astron brand, 902-928 MHz Half-Wave Dipole, with a swivel base, and 2
dBi gain. Because the antenna was on a swivel base, and because the EUT and the antenna
were connected via a 20 cm coaxial cable, the EUT was rotated along three orthogonal axis,
and the EUT antenna was positioned in both Horizontal and Vertical polarizations during the
investigations to find the highest emission levels.
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Test Equipment Utilized

A list of the test equipment and antennas utilized for the Radiated Emissions test can be found
in Appendix A. This list includes calibration information and equipment descriptions. All
equipment is calibrated and used according to the operation manuals supplied by the
manufacturers. All calibrations of the antennas used were performed at an N.I.S.T. traceable
site. In addition, the Connecting Cables were measured for losses using a calibrated Signal
Generator and a HP 8546A EMI Receiver. The resulting correction factors and the cable loss
factors from these calibrations were entered into the HP 8546A EMI Receiver database. As a
result, the data taken from the HP 8546A EMI Receiver accounts for the antenna correction
factor as well as cable loss or other corrections, and can therefore be entered into the database
as a corrected meter reading. The HP 8546A EMI Receiver was operated with a resolution
bandwidth of 120 kHz for measurements below 1 GHz (video bandwidth of 300 kHz), and a
bandwidth of 1 MHz for measurements above 1 GHz (video bandwidth of 1 MHz). From 5 GHz
to 10 GHz, an HP E4407 Spectrum Analyzer and an EMCO Horn Antenna were used.

Test Results

The EUT was found to MEET the Radiated Emissions requirements of Title 47 CFR, FCC Part
15.247 for a FHSS transmitter [Canada RSS-210, Clause 6.2.2(0)]. The frequencies with
significant RF signal strength were recorded and plotted as shown in the Data Charts and
Graphs.
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CALCULATION OF RADIATED EMISSIONS LIMITS

The maximum peak output power of an intentional radiator in the 902-928 MHz band, as
specified in 47 CFR 15.247 (b)(2), is 1 Watt for systems employing at least 50 hopping
channels. The harmonic and spurious RF emissions, as measured in any 100 kHz bandwidth,
as specified in 15.247 (d), shall be at least 20 dB below the measured power of the desired

signal, and must also meet the requirements described in 15.205(c).

The following table depicts the Class B limits for an unintentional radiator. These limits are
obtained from Title 47 CFR, Part 15.209, for radiated emissions measurements. These limits

were applied to any signals found in the 15.205 restricted bands.

Frequency 3 m Limit 3 m Limit 1 m Limit
(MHz) uv/m (dBuV/m) (dBpV/m)
30-88 100 40.0 -
88-216 150 43.5

216-960 200 46.0 -

960-24,000 500 54.0 63.5

Sample conversion from field strength uV/m to dBuV/m:
dBuV/m =20 log 10 (100)
=40 dBuV/m (from 30-88 MHz)

For measurements made at 1.0 meter, a 9.5 dB correction has been invoked.

960 MHz to 10,000 MHz
500uV/m or 54.0 dB/uV/m at 3 meters
54.0 + 9.5 =63.5 dB/uV/m at 1 meter

For measurements made at 0.3 meter, a 20 dB correction has been invoked.

960 MHz to 10,000 MHz
500uV/m or 54.0 dB/uV/m at 3 meters
54.0 + 20 = 74 dB/uV/m at 0.3 meters
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Radiated Emissions Data Chart

3 Meter Measurements of Electromagnetic Radiated Emissions
Test Standard: 47CFR, Part 15.205 and 15.247(FHSS)
Frequency Range Inspected: 30 MHz to 10000 MHz

Manufacturer: | Encom Wireless Data Solutions, Inc.
Date(s) of Test: | August 31°" through November 28™, 2004

Test Engineer(s): | Tom Smith |V | Abtin Spantman | | Ken Boston
Model #: | ‘ENC-900’ 1000 mW Radio Module
Serial #: | Engineering Unit #43
Voltage: | 3.80 VDC, 1000 mA

Operation Mode: | Normal, continuous transmit, and ‘Hopping’ mode

EUT Power: Single Phase VAC 3 Phase VAC
] Battery V| Other: Bench power supply

EUT Placement:

80cm non-conductive table

10cm Spacers

3 Meter Semi-Anechoic

EUT Test Location: | CCC Listed Chamber 3/10m OATS
Measurements: Pre-Compliance Preliminary \ | Final
Detectors Used: | ¥ Peak \ | Quasi-Peak \ | Average

Environmental Conditions in the Lab:

Temperature: 20 — 25°C

Relative Humidity: 30 — 60 %

Test Equipment Used:

EMI Measurement Instrument: HP8546A and Agilent E4407B

Log Periodic Antenna: EMCO #93146

Horn Antenna: EMCO #3115

Biconical Antenna:

EMCO 93110

The following table depicts the level of significant spurious radiated RF emissions found:

Frequency | Antenna Height Azimuth EMI Meter Reading 15.247 Limit Margin
(MHz) Polarity | Channel (meters) (0° - 360°) (dBuV/im) (dBuV/m) (dB)
Note 2

Notes

1) A Quasi-Peak Detector was used in measurements below 1 GHz, and an Average Detector was used
in measurements above 1 GHz. The Peak detector was also use to ensure that the emission levels
do not exceed 20 dB beyond the Average limits.

2) No significant spurious emissions observed. All spurious emissions were better than 20 dB below the

limits.
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Antenna 1:
Astron 902-928 MHz Half-Wave Dipole

The following table depicts the level of significant radiated RF fundamental and harmonic emissions seen on Channel 01:

Frequency | Antenna Height Azimuth Measured ERP 15.247 Limit Margin
(MHz) Polarity | Channel (meters) (0° - 360°) (dBuVv/im) (dBuV/m) (dB)
902.3 v 01 1.00 285 125.3 1312 5.9
1805 H 01 1.10 285 77.0 105.3 28.3
2707 H 01 1.10 175 49.7 54.0 4.3
3610 H 01 1.00 5 50.7 54.0 33
4512 \ 01 1.05 315 52.1 54.0 1.9
5414 \ 01 1.10 295 58.7 63.5 4.8
6317 H 01 1.00 15 57.2 105.3 48.1
7219 H 01 1.00 335 53.7 105.3 51.6
8122 H 01 1.15 65 56.4 63.5 7.1
9024 \ 01 1.05 75 48.2 63.5 15.3

The following table depicts the level of significant radiated RF fundamental and harmonic emissions seen on Channel 64:

Frequency | Antenna Height Azimuth Measured ERP 15.247 Limit Margin
(MHz) Polarity | Channel (meters) (0° - 360°) (dBpV/m) (dBuV/m) (dB)
914.9 \ 64 1.50 320 127.1 1312 4.1
1830 \ 64 1.00 110 62.8 107.1 44.3
2745 \ 64 1.00 90 46.9 54.0 7.1
3659 H 64 2.10 15 51.5 54.0 25
4574 H 64 1.10 245 50.5 54.0 35
5490 \ 64 1.10 50 61.3 63.5 2.2
6405 H 64 1.00 20 66.2 107.1 40.9
7320 H 64 1.00 330 59.2 63.5 4.3
8235 \ 64 1.05 180 52.8 63.5 10.7
9150 \ 64 1.00 325 48.0 63.5 15.5

The following table depicts the level of significant radiated RF fundamental and harmonic emissions seen on Channel 127:

Frequency | Antenna Height Azimuth Measured ERP 15.247 Limit Margin
(MHz) Polarity | Channel (meters) (0° - 360°) (dBuV/im) (dBuV/m) (dB)
927.5 \ 127 1.00 330 127.1 1312 4.1
1855 H 127 1.00 220 56.1 107.1 51.0
2783 H 127 1.10 180 49.6 54.0 4.4
3710 H 127 1.50 305 53.2 54.0 0.8
4638 H 127 1.25 245 52.3 54.0 1.7
5566 \ 127 1.15 50 60.9 107.1 46.2
6493 H 127 1.00 20 58.9 107.1 48.2
7421 H 127 1.00 330 52.3 63.5 11.2
8348 H 127 1.00 0 50.2 63.5 13.3
9276 \ 127 1.15 0 44.4 107.1 62.7

Notes: A Quasi-Peak Detector was used in measurements below 1 GHz, and a Peak as well as an Average Detector was used in

measurements above 1 GHz. Only the results from the Average detector are published in the table above. The peak detector
was used to ensure the peak emissions did not exceed 20 dB above the limits. Measurements above 5 GHz were made at 1
meters of separation from the EUT, and at 0.3 m separation at 18 — 26 GHz.
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Photos Taken During Radiated Emission Testing

View of the EUT setup in vertical orientation.

20cm
Extension
Coax

Control &
Power
Cables to
EUT

| Control &
Power

Cablesto | /70 '
EUT '\\ 12 VDC wall
< / Transformer
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View of the EUT setup on the test pedestal
With Antenna 1.
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Setup for testing of
Antenna 1

View of the EUT setup in vertical orientation
Antenna=Vertical ; EUT= Horizontal Antenna=Vertical ; EUT= Vertical

View of the EUT setup in Horizontal orientation
Antenna=Horizontal ; EUT= Horizontal Antenna=Horizontal ; EUT= Vertical
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Screen Captures of Radiated RF Emissions for Antenna 1:

Please note these screen captures represent Peak Emissions. For radiated emission measurements, we
utilize a Quasi-Peak detector function when measuring frequencies below 1 GHz, and an Average

detector function when measuring frequencies above 1 GHz.

The signature scans shown here are from worst-case emissions, as measured on channels 01, 64, or

127, with the sense and EUT antennas both in Vertical and Horizontal polarity.

Channel 127, Antenna 1 Vertically Polarized, 30-300 MHz, at 3m.
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Channel 127, Antenna 1 Vertically Polarized, 300-900 MHz, at 3m.
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Channel 127, Antenna 1 Vertically Polarized, 900-930 MHz, at 3m.

(@) 15:47:38 SCP 01, PAGY i
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Channel 127, Antenna 1 Horizontally Polarized, 930-1000 MHz, at 3m.

@ 15:30:53 SEF @81, 2AE4 Last Hrd
Key M
HARKER ACTU DET: PEAK e
966.65 MHz HEARS DET: FERK GF AWG SPAN
91,83 dBulsnm MER 9B6.B5 MH:z
91 .87 dBpMsm
LIMIT 1
;00 REF BB.H dBulsm ON OFF
dE s
i
18 dB —_—
LHT TEST
ON OFF
VA 5B L DELETE
LINIT
AN ity
e s it i EDIT
LIMIT
STRART 938, BA MH:z STOP {.AAABE CHz Prewious
R #1F BW 188 kHz #RAUG BW 1BE kH:z SHE 218 meec Menu
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Channel 127, Antenna 1 Horizontally Polarized, 1000-5000 MHz, at 3m.

(@3] 14:13:08 SCP 13, 2A0d i
AUERAGE BANDWIDTH ACTY DET: PEAK Key fenu
18 kHz MEAS DET: PEAK QP AYG -

MKR 3.715 Oz

B5. 14 dBylrm
LOG REF 80.8 dBul/m PREAMP o TTRHER
: )L

il

e MARKER
18 d8 a
NEXT
PE K
VA 58 NEXT PK
S0 FL RIOHT

RCORR .
L gt g NEXT PK
P LETT

M”UM

START 1.008 GHz S0P 5.880 OAz More
R #1F BW 1.0 MHz  BAUG BH 1B kH: SWP 1.9 sec 1 af ?

Channel 127, Antenna 1 Horizontally Polarized, 5000-10000 MHz, at 1m.

% Agilent  18:58:29 Sep 16, 2004 | Peak Search |
Mkrl 6.49 GHz|t
Ref 75 dBpV #Atten @ dB Ext PG -2.8 dB 68.52 dBpV
Peak Meas Tools»
Log 1
5 4
dB/ Next Peak
Marlker Next Pk Right
6.48000PBOA GHz
BBIG2 CIBIJU Next Pk Left
v ose|
$3 FC Min Search
A AR
Pk-Pk Search
Start 5 GHz Stop 10 GHz flore
#Res BW 1 MHz #UBH 1 MHz Sweep 12.5 ms (401 pts)
|
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20.

Band-Edge Measurements

FCC 15.209(b) and 15.247(d) require a measurement of spurious emission levels to be at least
20 dB lower than the fundamental emission level, in particular at the band-edges where the
intentional radiator operates. The following screen captures demonstrate compliance of the
intentional radiator at the 902.0-928.0 MHz band-edges. The EUT was operated in continuous
transmit mode, with modulation provided using a large test file for the data source. The EUT
was operated at the lowest channel, for the investigation of the lower band-edge, and at the

highest channel for the investigation of the higher band-edge.

Screen Capture demonstrating compliance at the Lower Band-Edge

% Agilent  17:27:26 MNov 28, 2004 | Marker |
Mkrl & —-308 kHz|t
Ref 48 dBm Atten 50 dB Ext PG -0.64 dB -31.62 4B |[select Marker
Peak
1 2 3 4
Log 1R
18 "
dB/ Normal
Marker & elta
—3@@.@@@ kH P Delta Pair
-31.62 dB {Tracking Ref)
Ref Deltal
s Span Pair
53 FC s C
AA pan enter
Off
Center 902 MHz Span 10 Mz flore
#Res BW 198 kHz #UBH 108 kHz Sweep 4 ms (401 pts)

Screen

Capture demonstrating compliance at the Higher Band-Edge

17:28:27 MNov 28, 2004

| Marker |
Mkrl & 538 kHz|t
Ref 48 dBm fAtten 50 dB Ext PG -0.64 dB -35.58 dB |[ elect Marker
Peak 1 o 3 4
Log 1R L
18
dB/ Normal
Manker & Delta
53&.@@@ kHZ @ Delta Pair
-35.58 dB {Tracking Ref)
Ref Delta|
s Span Pair
53 FC s C
AR pan enter
Off
Center 928 Mz Span 10 Mz flore
#Res BW 198 kHz #UBH 108 kHz Sweep 4 ms (401 pts)
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21. Conducted RF Emissions Test, on AC Power Line

Test Setup
The Conducted Emissions test was performed at L.S. Compliance, Inc. in Cedarburg,

Wisconsin. The test area and setup are in accordance with ANSI C63.4-2003 and with Title 47
CFR, FCC Part 15 (Industry Canada RSS-210). The EUT was placed on a test fixture, on top of
a non-conductive wooden table, with a height of 80 cm above the reference ground plane.
Antenna 1, the Astron 902-928 MHz antenna was used for these tests. The EUT’s power source
was plugged into a 50Q2 (ohm), 50/250 puH Line Impedance Stabilization Network (LISN). The
AC power supply of 120V was provided inside the Shielded Test Room via an appropriate
broadband EMI Filter, and then to the LISN line input. Final readings were then taken and
recorded. After the EUT was setup and connected to the LISN, the RF Sampling Port of the
LISN was connected to a 10 dB Attenuator-Limiter, and then to the HP 8546A EMI Receiver.
The EMCO LISN used has the ability to terminate the unused port with a 50Q (ohm) load when
switched to either L1 (line) or L2 (neutral).

Test Procedure

The EUT was investigated in continuous modulated transmit mode for this portion of the testing.
The appropriate frequency range and bandwidths were selected on the EMI Receiver, and
measurements were made. The bandwidth used for these measurements is 9 kHz, as specified
in CISPR 16-1 (2003), Section 1, Table 1, for Quasi-Peak and Average detectors in the
frequency range of 150 kHz to 30MHz. Final readings were then taken and recorded.

Test Equipment Utilized

A list of the test equipment and accessories utilized for the Conducted Emissions test is
provided in Appendix A. This list includes calibration information and equipment descriptions.
All equipment is calibrated and used according to the operation manuals supplied by the
manufacturers. Calibrations of the LISN and Limiter are traceable to N.I.S.T. All cables are
calibrated and checked periodically for conformance. The emissions are measured on the
HP 8546A EMI Receiver, which has automatic correction for all factors stored in memory and
allows direct readings to be taken.

Test Results

The EUT was found to MEET the Conducted Emission requirements of FCC Part 15.207
Conducted Emissions for an Intentional Radiator. See the Data Charts and Graphs for more
details of the test results.
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Calculation of Conducted Emissions Limits

The following table describes the Class B limits for an unintentional radiator. These limits are obtained from
Title 47 CFR, Part 15.107 (a) for Conducted Emissions.

Frequency (MHz) Quasi-Peak Limit (dBuV) Average Limit (dBuV)
0.15-05 66 — 56 * 56 - 46
05-5.0 56 46
5.0-30.0 60 50

* Decreases with the logarithm of the frequency.

Sample calculation for the limits in the 0.15 to 0.5 MHz:

Limit = -19.12 ( Logso ( F[MHz] / 0.15 [MHz] )) + 66.0 dBuV

For a frequency of 200 kHz for example:
Quasi-Peak Limit (F = 200kHz) = -19.12 ( Logo ( 0.2[MHz] / 0.15 [MHz] )) + 66.0 dBuV

Quasi-Peak Limit (F = 200kHz) = 63.6 dBuV

Average Limit (F=200kHz) = -19.12 (Log10(0.2[MHz]/0.15[MHz])) + 56.0 dBuV

Average Limit (F = 200 kHz) = 53.6 dBuV
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Measurement of Electromagnetic Conducted Emission

Frequency Range inspected: 150 KHz to 30 MHz
Test Standard: FCC 15.207 (a)

Manufacturer: | Encom Wireless Data Solutions, Inc.
Date(s) of Test: | August 31°" through November 28'", 2004
Test Engineer: | Tom Smith | V| Abtin Spantman | | Ken Boston
Model #: | ‘ENC-900’ 1000 mW Radio Module
Serial #: | Engineering Unit #43
Voltage: | 3.80 VDC, 1000 mA
Operation Mode: | Normal, continuous transmit, and ‘Hopping’ mode
Test Location: 2// Shielded Room Chamber
. 40cm from Vertical Ground Plane 10cm Spacers
SOt oh \ | 80cm above Ground Plane Other:
Measurements: Pre-Compliance Preliminary \ | Final
Detectors Used: Peak \ Quasi-Peak \ | Average

Environmental Conditions in the Lab:

Test Equipment Utilized:

Temperature: 20 -25°C
Atmospheric Pressure: 86 kPa — 106 kPa
Relative Humidity: 30 — 60%

EMI Receiver: HP 8546A
LISN: EMCO 3816/2NM
Transient Limiter: HP 119474A

QUASI-PEAK AVERAGE
Frequency Q-Peak Q-Peak | Quasi-Peak | Average Average | Average
(MHz) Line Reading Limit Margin Reading Limit Margin
(dBpV/m) | (dBu V/m) (dB) (dBpV/im) | (dBu V/m) (dB)
0.16 L1 47.3 65.5 18.2 19.9 55.5 35.6
0.32 L1 42.6 59.7 17.1 16.5 49.7 33.2
0.45 L1 39.1 56.9 17.8 13.0 56.9 43.9
0.49 L1 38.2 56.2 18.0 11.6 46.2 34.6
0.55 L1 36.7 56.0 19.3 10.0 46.0 36.0
0.16 L2 49.2 65.5 16.3 20.0 55.5 35.5
0.22 L2 45.1 62.8 17.7 15.7 52.8 37.1
0.25 L2 42.8 61.8 19.0 14.3 51.8 37.5
0.74 L2 37.8 56.0 18.2 10.3 46.0 35.7
Notes:

1) The emissions listed are characteristic of the power supply used, and did not change by the EUT.

2) All other emissions were better than 20 dB below the limits.

3) The EUT exhibited similar emissions in transmit and receive modes, and across the Low, Middle and High
channels tested. Data presented above is from the Middle channel 64.
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Photo(s) Taken Durinqg Conducted Emission Testing

Setup for the Conducted Emissions Test
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Screen Captures of Conducted AC Mains Emissions:

Please note these screen captures represent Peak Emissions. For conducted emission measurements,
we utilize both a Quasi-Peak detector function as well as the Average detector function for
measurements. The emissions must meet both the Quasi-peak limit and the Average limit as described in
47 CFR 15.209.

The signature scans shown here are from channel 64, chosen as being a good representative of
channels.

Channel 64, Line 1

[G7) 18:44:37 NOU 28, 2BEY o ha
Key M
STOP ACTU DET: PLAK By e
3@.88 MHz MERS DET: PERKE OF ALG SPAN
NKR 158 kHz
53.91 dBul
LOG REF B5.8 dBul MH?“EE
18
dE s
ATH PRSS [LIMIT MARKER
10 dB 4
-\R_H_H""“-\_\_\_
NEXT
iGN PEAK
WA 5B N HEXT PE
SCTL TT*M RIGHT
ACORR — WP
b e )| vExT P
LEFT
START 150 kHz STOP 38.08 HH: Nore
RL #1F BW 9.8 kHz AUG BH 3B kHz SWF 2.49 sec { of P
Channel 64, Line 2
(@3] 19:13:13 NOU 28, 2@ oot frd
Koy I
HARKER ACTU DET: PERK SR
168 kHz MERS DET: PERK QP AVE —
58.16 dBuV MER 1BB kHz
58.16 dBul
LOG REF 85.8 dByU EEEEEE
18
il
o FAIL LIMIT 8 MARKER
18 db s
H‘“-E_‘_
| MARKER
i ANPTD
il
VR SR ! K ] SELELCT
S FC Nx 1234
RCORR i R i
e g | MARKER 1
a OfF
START 158 kHz 5T0F 39.68 MMz Nore
RL #IF BN 9.8 kH: AUG BH 30 kHz SWP 2.49 sec 1 of 3
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22, Receiver Synchronization

Each receiver requires the same seed for the pseudorandom sequence generator as the
transmitter with which it is operating. The same seed will produce the same hop sequence in
each device. Once the receiver scans and finds the transmitter on any given channel it will
automatically be synchronized to go to the next correct channel by virtue of using the same
hopping table.

23. Receiver Input Bandwidth

The radio receiver is a direct conversion type with a baseband filter whose cutoff frequency is
matched to the transmission spectrum. The bandwidth is 600 kHz for use at the 115 kbps rate.
Two level frequency shift keying is used for modulation. The simple Carson bandwidth for this
type of signal is given as the bit rate plus 2 times the deviation. This system uses 170 kHz
deviation for the 115 kbps rate, giving a bandwidth of 340 kHz. The excess filter bandwidth
allows for frequency tolerance errors between the transmitter and receiver.
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24. MPE Calculations

MPE Calcluation

Antenna 1
Astron 902-928 MHz Half-Wave Dipole

Prediction of MPE limit at a given distance

Equation from page 18 of OET Bulletin 65, Edition 97-01
PG
S=—173%
47R

where: S = power density
P = power input to the antenna

G = power gain of the antenna in the direction of interest relative to an isotropic radiator
R = distance to the center of radiation of the antenna

Maximum peak output power at antenna input terminal: 29.11 (dBm)
Maximum peak output power at antenna input terminal: 814.704 (mW)
Antenna gain(typical): 2 (dBi)
Maximum antenna gain: 1.585 (numeric)
Prediction distance: 20 (cm)
Prediction frequency: 915 (MHz)
MPE limit for uncontrolled exposure at prediction frequency: 0.61 (MW/cm”"2)
Power density at prediction frequency: 0.256880 (mW/cm”2)
Maximum allowable antenna gain: 5.8 (dBi)
Margin of Compliance at 20 cm= 3.8 dB
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Appendix A

Test Equipment List

Asset # Manufacturer Model # Serial # Description Date Due
Line Impedance Stabilization
AA960008 | EMCO 3816/2NM 9701-1057 Network 9/15/04 9/15/05
AA960031 HP 119474A 3107A01708 Transient Limiter Note 1 Note 1
AA960077 EMCO 93110B 9702-2918 Biconical Antenna 9/16/04 9/16/05
AA960078 | EMCO 93146 9701-4855 Log-Periodic Antenna 9/16/04 9/16/05
AA960081 | EMCO 3115 6907 Double Ridge Horn Antenna 11-14-03 11-14-04
CC00221C | Agilent E4407B US39160256 Spectrum Analyzer 11-04-03 11-04-04
EE960004 | EMCO 2090 9607-1164 Device Controller N/A N/A
EE960013 HP 8546A 3617A00320 Receiver RF Section 9/16/04 9/16/05
EE960014 | HP 85460A 3448A00296 Receiver Pre-Selector 9/16/04 9/16/05
N/A LSC Cable 0011 3 Meter %" Armored Cable Note 1 Note 1
N/A LSC Cable 0038 1 Meter RG 214 Cable Note 1 Note 1
N/A LSC Cable 0050 10 Meter RG 214 Cable Note 1 Note 1
N/A Pasternack Attenuator N/A 10 dB Attenuator Note 1 Note 1

Note 1 - Equipment calibrated within a traceable system.

Uncertainty Statement

This uncertainty represents an expanded uncertainty
expressed at approximately the 95% confidence level, using a coverage factor of k=2.

Table of Expanded Uncertainty Values, (K=2) for Specified Measurements

Measurement Type Particular Configuration Uncertainty Values
Radiated Emissions 3 — Meter chamber, Biconical Antenna 4.24 dB
Radiated Emissions 3-Meter Chamber, Log Periodic Antenna 4.8dB
Radiated Emissions 10-Meter OATS, Biconical Antenna 4,18 dB
Radiated Emissions 10-Meter OATS, Log Periodic Antenna 3.92dB

Conducted Emissions Shielded Room/EMCO LISN 1.60 dB
Radiated Immunity 3 Volts/Meter in 3-Meter Chamber 1.128 Volts/Meter
Conducted Immunity 3 Volts level 1.0V
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Appendix B — Antenna Specification Sheets

Antenna 1 Specification

Wireless Technologies, Inc.

Antennas - RF Components « System Integration

Electrical Properties:

Frequency Range: 902~828 MHz

Impedance: 500 nominal
VSWR: <2.0:1

Gain: *2.0 dBi
Radiation: Ompni
Palarization: Vertical

Wave: Half Wave Dipole

_Mechanical Properties:

‘® Material:
& Whip: Polyurethene(Black)
n Connector: Brass with
2 black chrome plating
) Operation Temp.: —-20'C to +65°C
. Storage Temp.: —30'C to +75C
o0
20.15(12.9)] ggé?gﬁﬂ!’
1o INFORMATION/DATA

22560 Glenn Drive, Suite 114 - Sterling, Virginia 20164-4440 « 703.450.5517 - Fax: 703.450.9753 www.astronwireless.com - www.lepro.net
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Appendix C

Firmware and Setup Instructions

Procedure for operating Encom Units in Continuous mode

Power up the EUT & connect to PC via RS232
Launch a terminal program on PC such as Teraterm.
If you are using “Hyper Terminal” to send the text file, check the followings:
“properties — ASCII” setup, line delay and character delay fields should all set to zero.
Handshaking set to “NONE”"
Baud rate = 115200 bps
If you are using “Teraterm” to send the text file, check the followings:
Baud rate = 115200 bps
All other fields should be already set
While in terminal program, type the following (note: it is NOT user friendly):
Type “AT” [enter] to engage
Type “ATMC” [enter] to go into calibration mode
Type “ux1” [enter] for channel 1, ux64 for channel 64, or ux127 for channel 127
Type “t3” [enter] to set the EUT at full power out

Note: you will not get any acknowledgement after typing “ux64” [enter], or “t3” [enter].

To change channels, while in terminal program, type “ux1/64/127” depending on channel
and “t3”. Don’t forget the “t3”.
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Firmware and Setup Instructions - continued

Procedure for operating Encom Units in HOP mode

Power up the EUT & connect to PC via RS232

Launch a terminal program on PC such as Teraterm.
If you are using “Hyper Terminal” to send the text file, check the followings:
“properties — ASCII” setup, line delay and character delay fields should all set to zero.
Handshaking set to “NONE”
Baud rate = 115200 bps
If you are using “Teraterm” to send the text file, check the followings:
Baud rate = 115200 bps
All other fields should be already set
While in terminal program, type the following (note: it is NOT user friendly):
Type “AT&V” [enter] to check the current settings
Type “ATS101=1" [enter] to program radio in Master mode
Type “ATS109=5" [enter] to set the maximum dwell time to 30ms
Type “ATS111=100" [enter] ‘Minimum packet size = 100 bytes
Type “ATS112=200" [enter] to set the maximum packet size to 200 bytes.
Type “ATS116=10" [enter] ‘character timeout = 10ms
Type “ATS117=0" [enter] ‘TX buffer ON
Type “ATS120=10" [enter] ‘RTS/CTS delay time = 10ms
Type “ATS121=2" [enter] ‘RTS/DCD turn off delay time = 2ms
Type “AT&k0” [enter] ‘Hardware handshaking OFF
Type “AT&V” [enter] to double check the change you have made,
Type “AT&W?” [enter] to save this change to FLASH,
Type “ATA” [enter] to put radio into “DATA MODE”

While still in terminal program, go to the command line:
File > Send File > C:\Abtins folder\O0O.WAYV [Enter]

Dumps a very long file (689MB) using “ASCII” protocol, giving you approximately 30 minutes of run time.
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